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PRESS RELEASE

FOR IMMEDIATE RELEASE

Active Tables for Adobe InDesign now available as a public beta
Prague EU, May 23, 2010 – DTP Tools announces the release of Active Tables plug-in for Adobe InDesign. Active Tables plug-in turns InDesign 

catalogues that update prices for entire catalog with just one click, change sales tax for entire catalog in one place, create invoices and price lists. 
Formulas can process text and conditions, such as adjust tax amount on the invoice automatically based on the customer location.

KEY FEATURES

Create formula in table cell

Use cells from any table within a document for a calculation 
Sort table rows and columns based on multiple criteria 
Format results as text, number, currency, percentage, scien -

or negative 

Show grid coordinates for tables List tables in the document

editor + any other added on request

PRICING AND AVAILABILITY

Active Tables plug-in is sold for €59 / $79 per license. The 14–days trial version for InDesign CS3 – CS5, and for Mac OS and Windows, is available 
for immediate download at:  
www.dtptools.com/active tables

or at the direct download links:

MAC: www.dtptools.com/activetables/Active_Tables_1.0.zip WIN:  www.dtptools.com/activetables/Active_Tables_1.0.msi

About DTP Tools

DTP Tools is a leading provider of InDesign and InCopy solutions. With widely-renowned plug-ins such as History, Cross-References, and Page 

time and money in the production process! For more information, email info@dtptools.com
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License Agreement
Please read this document carefully.
The “SOFTWARE” refers to the computer program and all documentation accompanying this License Agreement.  “USE” the SOFTWARE means that 
the SOFTWARE is either installed on the permanent memory of a computer (hard disk or similar storage device) or loaded in the temporary memory 
of computer or running it on a central processing unit.
“Permitted Number” means one (1) unless otherwise indicated under a valid license (e.g. volume license) granted by DTP Tools.
This End-User License Agreement (“LICENSE”) is a legal agreement between you (either an individual or a single entity who purchased the SOFTWARE 
and is entering into this License Agreement) and DTP Tools Limited (“DTP Tools”). By installing, copying or otherwise using of SOFTWARE you accept 
all terms and conditions of this LICENSE.

1. Grant of License.   This License allows you to Install and USE a Permitted Number of copies of the SOFTWARE on your Computer, up to the Permitted 
Number of Computers.  This  License entitles you to one change of host application or platform, provided that you will not USE more than Permitted 
Number of copies simultaneously. You may also permanently transfer all your rights in the SOFTWARE to another party, provided that other party 
reads and agrees to accept the terms and conditions of this LICENSE. Immediately upon transfer, you have no further rights to use the SOFTWARE 
and you must destroy copies in your possession.

2. Ownership.   The SOFTWARE is licensed, not sold, to you for USE only under the terms and conditions of this LICENSE. DTP Tools reserves all rights 
not expressly granted to you in this LICENSE. DTP Tools and/or its licensors retain title to the SOFTWARE and all intellectual property rights therein.

3. Restrictions.   The only right granted to you is the right to USE the SOFTWARE in accordance with this LICENSE. The SOFTWARE contains copyrighted 
material and other proprietary material of DTP Tools and its licensors. You may not modify, decompile, reverse engineer, disassemble or otherwise 
reduce any part of the SOFTWARE. You may not resell for profit, rent, lease or loan this SOFTWARE. This LICENSE does not grant you any rights in 
connection with any trademarks or service marks of DTP Tools and its licensors.

4. Termination.   This LICENSE is effective until terminated. Any failure to comply with terms and conditions of this LICENSE shall immediately result 
in automatic termination of this LICENSE. Upon termination of this LICENSE for any reason, you must destroy all copies of the SOFTWARE. You may 
also terminate this LICENSE at any time by destroying all copies of the SOFTWARE. 

5. Disclaimer of Warranty.   The SOFTWARE is provided “AS IS” and without warranty of any kind. You expressly acknowledge and agree that USE of 
the SOFTWARE is at your sole risk. You acknowledge that the SOFTWARE may not satisfy all your requirements.  DTP Tools and its licensors expressly 
disclaim all other warranties with respect to the SOFTWARE, whether such warranties are express or implied. DTP Tools makes no warranty that 
the functions contained in the SOFTWARE will run uninterrupted or error-free, that defects in the SOFTWARE will be corrected, nor with respect 
to the correctness, accuracy or reliability of the SOFTWARE. No oral or written information or advice given by DTP Tools or any of its employees or 
representatives shall create any warranty in addition to those given herein. Some jurisdictions do not allow the exclusion of implied warranties, so the above 
exclusion may not apply to you. 

6. Limitation of Liability.   Under any circumstance shall DTP Tools be liable for any incidental, special or consequential damages that result from 
the USE or inability to USE the SOFTWARE under any theory. Some jurisdictions do not allow the limitation or exclusion of liability for incidental or 
consequential damages, so the above limitation or exclusion may not apply to you. In no event shall DTP Tools’s total liability to you for all damages, 
losses and causes of action exceed the amount paid by you for the specific license of the SOFTWARE to which the liability is related.

7. Export Restrictions.   You agree and certify that neither the SOFTWARE nor any other technical data received from DTP Tools, nor the direct product 
thereof, will not be exported or transmitted to any country to which such export or transmission is restricted by regulation or statute of the United 
States government. You shall comply with all applicable export regulations.

8. Governing Law and Severability.   This License Agreement shall be construed and governed by the laws of the Czech Republic. If for any reason 
a court of competent jurisdiction finds any provision of this LICENSE to be unenforceable, that provision of the LICENSE shall be enforced to the 
maximum extent permissible so as to effect the intent of the parties, and the remainder of this LICENSE shall continue in full force and effect.

License Agreement

License
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Annotations panel

1.1 Annotations Panel
Shows a list of all annotations in the document.
 

Alt+Click on the list item will bring you to the selected source marker.

Annotations Panel

•	 Annotations Panel
•	 Annotations Panel 

Menu

TIP: To show these panels 
choose
Window à Annotations

1.2 Annotations Panel Menu
Contains additional commands for processing notes and edi

Import Annotations – Opens dialog Import annotations p.7

Clear All – Deletes every annotation from the document, including the 
swatches used for them (if these are assgned to an object, you will be given the option to 
keep the swatches)

Previous Annotation – Jumps one annotation up in the list and shows 
it in the document.

Next Annotation – Jumps one annotation down in the list and shows 
it in the document.

Show All Popups – Displays a frame in the document for every annota-
tion that has a text comment or edit.

Hide All – With this settings on, note contents is only visible in the 
panel.

Show Selected Only –  Displays a frame in the document for all annota-
tions selected in the panel.

Jump To The Next Text Edit – When this setting is on, InDesign auto-
matically jums to next note when one is accepted or rejected.
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Panel buttons  
+ other UI

•	 Insert New Note
•	 Accept text change
•	 Reject text change
•	 Accept all text changes
•	 Reject all text changes
•	 Delete
•	 Type menu command

TIP:  You can also assign 
keyboard shortcuts to accept 
and reject buttons for more 
efficient workflow.

Button Annotation type Use

Insert New Note Click on this button and the note will be created in place of your next 
click in the document.

Accept text change Click on this button when one or more text edits are selected to 
propagate the change from edit into the document text.

 Reject text change
Click on this button when one or more text edits are selected to 
delete them from the annotations list without applying the changes 
to the original text.

Accept all text 
changes

Every change that you can accept or reject in the document will be 
accepted and the changes applied to the text.

Reject  all text 
changes

Every change that you can accept or reject in the document will be 
rejected and the edits will be removed from the annotations list with-
out applying the changes to the text.

Delete Removes one or more selected annotations from the list.

A command for deleting all annotations is also in menu Type -> Annotations.
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Annotation types
•	 Sticky note
•	 Text Highlights
•	 Text Edits
•	 Drawing Markups

TIP: Drawing Markups can have 
a note attached. If present, you 
will see it in the lower section 
of the panel.

Icon Annotation type Description / sub-cathegories

 Sticky note

Sticky note - can be imported to the same spot as in pdf, or created in 
InDesign.

Contents of the note can be read in the bottom part of the panel or in a 
special note frame in the document.

 Text Highlight

Text Highlight puts a color rectangle under the text and sometimes has 
a note attached. 

The note text is in the bottom part of the panel, or in the frame next to 
the page. 

Text Edit

Inserted, deleted or replaced text via Acrobat comment and markup 
tool. 

This edit can be accepted or rejected. Accepting the text propagates the 
change into the original text flow. 

Underlined text - underlined text can come with a attached note dis-
played in the panel part bellow the notes list 

Crossed out text - text marked for deletion. Accepting this change will 
delete the text from the original text flow. 

Text edits can be accepted one by one or as batch for the entire document.

Drawing Markup
Callout Box is a text frame with arrow pointing to the entry point 

Text Box is a text frame with note in it.

Cloud is a rectangle around the area of interest

Line drawn using the Acrobat’s comments and markup Line tool

Rectangle drawn around the area of interest

Oval is an elipse drawn around the area of interest

Polygon line

Polygon shape drawn using connected polygon lines

Arrow pointing to the area of interest  

Pencil tool markups are not imported in this version
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Import 
annotations
•	 Choosing file
•	 Choosing note types
•	 Matching pagination

TIP: When importing notes to 
the document, a new swatch 
for the notes box will be cre-
ated. 

How to import Annotations

•• Go to Annotations panel menu à Import Annotations.

•• Select the PDF file with notes to import from the list, clicking on the 
Browse word lets you choose from anywhere on the computer or 
network.

•• Select the Annotation types to be imported (see opposite page)

•• If the InDesign document and the PDF have a differ-
ent number of pages, you should match the first page 
of the shorter document with a page in the longer one.  
(1) If the PDF has more pages than the InDesign document (perhaps 
it was created for a whole book file and  you’re importing into just one 
chapter), find the page number in the PDF which corresponds with the 

first page of your InDesign document and enter in in the PDF field. 
(2) If the InDesign file contains more pages than the PDF (you’ve 
only sent portion it for review, or you’ve exported as spreads), 
find the page number of the InDesign document that corre-
sponds with the first page in the PDF.

•• Click on Import button and wait while the annotations are being 
placed and loaded. After that you will see all imported notes and 
edits listed in the Annotations panel. If something goes wrong 
with the import, you’ll get one of the warning or error messages 
(for explanation of error messages see next page).
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Import Errors
•	 Page Size Mismatch
•	 Text Edit Collision
•	 Unimported 

Annotations
•	 General warnings and 

problems

TIP: If possible, try keeping 
the source file intact from time 
you send out the PDF for ed-
iting until it comes back. This 
ensures the lossless import.

This error message sums up the number of annotations that were not im-
ported. Along these can be freehan drawing markups (unsupported) or 
text edits on text which is on a position different from the one in PDF.

This error message appears when you try to import notes from a PDF file with 
a different page size. Annotations plug-in can process files exported with 
crop marks or bleed and even exported as spreads, as long as the printable 
page sizes do not differ more than few points. 

If you already imported some annotations into current document and kept 
some of the text edits, you might not be able to import colliding text edits 
to the same spot. 

If you notice any problems with importing supported annotations from 
identical documents or any other problems and concerns, let us know at  
support@dtptools.com , preferably with the indd and pdf files attached. 
Your feedback helps to improve the product.

!
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Recommended workflow
After you get the notes and edits loaded in the document, you can 
start processing them. If the document is edited properly and only 
the tools designated for editing and commenting text were used in 
Acrobat, you can start from top down with the Jump to Next Text 
Edit feature turned on in the panel menu. You can assign a keyboard 
shortcut to accepting and rejecting edits (Preferences -> Keyboard 
Shortcuts -> Annotations). This way you can just press one of the key 
combinations and get the text changed, while navigating from one 
edit to the next one.
If your collaborator or customer used also the yellow sticky notes and 
drawing markups for text edits, we recommend working from bottom 
up, because this way you get to each note before the edits in the text 
flow above change the position of the text (sticky notes and drawings 
are relative to page position, not text).

Showing and hiding annotations
When you turn on the print preview (W key), annotations will not 
display in the document (they don’t print). If you want to hide just the 
sticky note anchor icons and drawing markups, you can do that by 
hiding Guides View -> Grids & Guides -> Hide Guides (or Ctrl/Apple +)
Boxes with notes text are shown or hidden using commands in 
Annotations panel menu.

Compatibility
While the Annotations are present and saved in the file, it will request 
the Annotations plug-in upon opening in InDesign without this plug-
in installed. If you need this document to be edited by someone not 
using the Annotations plug-in, you can either ask them to install the 
free reader version (available at www.dtptools.com/annotations ), or 
remove all notes and edits either from the panel, or from the Type 
Menu -> Annotations
The Free reader plug-in allows safe editing and maintaining of the 
notes and also has the function for deleting all notes and edits in the 
document. 
When importing annotations, the plug-in creates a set of swatches 
used for drawing notes, highlights and markups (this allows you to 
change their color too). We advise not to assign these swatches to any 
objects in the document. When all annotations are deleted from the 
document, the plug-in also removes the swatches. If some of these are 
assigned to your objects, you can choose to keep the swatches in the 
document, or to delete them.

If you click yes, the annotations related swatches will remain in your 
document. If you click no, you will be asked to assign one replace-
ment swatch for the deleted ones.

Processing imported 
annotations
•	 Recommended  

practices
•	 Showing and hiding 

notes
•	 Compatibility

TIP: The most efficient use of 
Annotations requires your col-
laborators to use the correct 
tools in Acrobat or Acrobat 
Reader. By improving their skills 
you can make your job easier.
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Purchasing 
After installation, Annotations plug-in will be in the try–out mode. To get all the benefits 
of the fully functional software, you need to purchase it. To carry out the purchase ,choose  
DTP Tools1  à Buy Annotations now…  or click the purchase link in the intro screen. Your 
computer needs to be connected to internet to make a purchase. The eSellerate Software 
Delivery Wizard will guide you through the purchase. Choose Start in the Software 
Delivery Wizard dialog.

The next dialog contains the License Agreement. Please read it carefully. You can also save 
the text of License Agreement for future reviewing. To proceed with your purchase, you 
must agree with the conditions of Agreement. After indicating so, click on the Next button. 
For the address field use the billing address for the credit card used for the transaction.
For the email address you enter, you will receive Order confirmation e-mail, con-
taining all information regarding the transaction and product’s serial number.
If you do not wish to receive information about product updates and offers, make 
sure this item is not checked.
If the billing address you selected at the Personal Information screen was for a 
country in the European Union, you will have the option to enter a Value Added 
Tax (VAT) ID number. The VAT ID applies only to qualified business customers 
from the European Union. All other customers should leave this field blank. If 
VAT applies to your purchase, you will find the specific amount after proceeding.
After you specify the quantity of licenses you want to buy, you will see a total 
price with volume discounts included. To find out more about current volume 
and cross–platform discount policy for Annotations, follow the link Volume and 
cross–platform discounts available. 
If there are any Coupons applicable, you will have the option to enter a Coupon 
ID to obtain the discount.

1 DTP Tools menu is located in Help menu on Windows and InDesign menu on Mac

Buying more 
licenses

If you need to use this plug–in on more than one computer, you can buy more licenses within the application. The 
plug-in, which you used for purchase, will activate automatically.  
To activate remaining copies 

Volume discounts A volume discount is a price reduction applicable if you purchased more licenses of the product.  
If purchasing amounts exceeding those specified in the discounts table, please contact sales@dtptools.com

Cross–platform 
discount 

Cross–platform discounts is an expansion of usual volume discount. It enables you to use a total number of licenses 
purchased for Windows® and Macintosh® edition of the plug-in to calculate the discount. Simply choose one of the 
platforms and use the serial number for activation of all installations regardless of the platform. 

Online store Annotations plug-in is also available for sale in DTP Tools online store. For online purchase visit  www.dtptools.com 
If you prefer other ways of purchasing, please contact us at sales@dtptools.com.

Purchasing
•	 Buying in the 

application
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To proceed with the transaction, fill in your credit card information. 
If the billing address you selected at the Personal Information screen was for a coun-
try other than the United States, you will have the option to select a local currency  
(if that currency is supported). This option is supported for Visa and MasterCard 
only.
If the billing address you selected at the Personal Information screen was in the 
European Union country, the purchase will be subject to a Value Added Tax (VAT). 
Unless you entered a valid VAT ID as a qualified business customer, the order total 
will include VAT.
Your order will be processed after confirming the information. If everything is cor-
rect, click on the submit button in the following dialog.
For more information about security follow the link eSellerate security.
You can save or print confirmation page, which contains all information you 
might need for future reinstallations, upgrading or “switching” of Annotations.
After purchase will the Buy Annotations now… item disappear from the DTP Tools menu.

Reinstallation   
When you reinstall a copy of Annotations that was already purchased and subsequently uninstalled, you need to reactivate it. Your computer 
needs to be connected the Internet during reinstallation. This option is not available for CS3 Macintosh version. It can be fully replaced by 
Choose DTP Tools1  à Buy Annotations now…  Hold Alt key in the first dialog of Software delivery wizard. The Reinstall button will appear in 
place of Start button.
To verify that your order was previously processed, please enter your Order number (you will find it on Receipt or in Order Confirmation e-mail 
you received after buying Annotations).  Your order number will start with letters ST (for example, ST123456).
There is a limit of three reinstallations per license. Once you reach this limit, you need to contact support@dtptools.com  before reinstalling again.

1 DTP Tools menu is located in Help menu on Windows and InDesign menu on Mac

Hold “Alt” to see Reinstall button

Purchasing

•	 Buying in the 
application 
(continued)

Reinstallation
•	 Reinstallation
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Standard Activation procedure
Annotations are activated automatically when the purchase is done within application. However, when you purchase from the web-store or 
from a reseller, you need to activate it. When you buy more than one license from within the application, only the plug-in on the computer 
you’ve used for purchasing will be activated. Remaining copies need to be activated too. 
To do so choose DTP Tools1  à Activate. You will be prompted for your serial number - it is in your order confirmation e-mail. 
Your computer has to be connected to the Internet during activation. If this is not possible, please follow the  procedure described bellow.

Activation message Countermeasure

Entered serial number has incorrect length. Please check whether 
you typed or copied the whole serial number.  

If you were copy/pasting the number, there is most likely an extra 
space after the last character, or the last four numbers missing.

Entered serial number is not valid. Please check whether you typed 
or copied it correctly.

DT-106-XXX-XXXX-XXXX-XXXX-XXXX-XXXX - this is a correct form of the 
serial number. The serial number is in your order confirmation e-mail.

To finish DTP Tools plug-in installation, please restart InDesign/In-
Copy with Administrator privileges.

Privileges of your user account are not sufficient to save the activation 
data. Please log-in as an administrator and start the application again.

eSellerate Engine is not installed or has been damaged. Please unin-
stall and reinstall your DTP Tools product.

Download the latest installer from www.dtptools.com/Annotations 
and run it on your computer.

That serial number is unrecognized. Please check the number and 
try again.

If you have purchased your license in the web-store, please wait 20 min-
utes before you start the activation.  If the problem persists, it might be 
caused by proxy settings and can be solved by 

Serial number is blacklisted. Please contact support@dtptools.com .

Our records indicate that this product was returned by the pur-
chaser, and its serial number retired. If you believe our records are in 
error, please contact us.

Please contact us with your order details, we’ll double check our 
records.

Our records indicate that this product has already been activated 
the maximum number of allowed times.

Please contact support@dtptools.com to get additional activation.

No product on this computer is activated by this serial number. Download and install the try-out version of the plug-in and try again.

Serial number is already associated with another order. Please contact us with your order details, we’ll give you a new S/N.

The activation server has deemed to deny the action requested. Please try again in a minute or two.

Activation was not successful. Please check your internet connection 
and try again. If you receive this message again, please check the 
‘Manual Activation’ box to activate this product via a Web interface.

If you are connected to the internet and still get this message, it is 
caused by the proxy settings.  is a safe workaround for this problem.

Activation completed successfully. Thank you for choosing DTP Tools! Hurray! This message means your plug-in is now a full version.

1 DTP Tools menu is located in Help menu on Windows and InDesign menu on Mac

Activation
•	 Standard Activation

TIP: If you’ve purchased your 
license through the Web store, 
it may take up to 20 minutes 
for the store to notify all activa-
tion servers and authorize your 
serial number. Therefore, if you 
receive an ‘unknown serial 
number’ message, please wait 
several minutes and try again.
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Activation

•	 Manual Activation
•	 Activation Transfer

TIP:  Problems with activation 
caused by Macintosh Proxy set-
tings can be avoided by using 
manual activation.

Manual Activation
Choose activate, and check Manual Activation checkbox in the Activation dialog. Fill in the serial number and hit Activate. You will be offered 
to either Activate using a web browser on this computer, or to Activate using different computer that has web access, or to enter an Activation 
Key (provided you already got one).
Activate using a web browser on this computer - You will be brought to a web page with pre-filled installation ID. You only need to click Submit 
button to get the Activation Key. Copy the key and return to the Activation Dialog and click next until you’ll see the field to fill the key into.
Activate using different computer that has web access - You will obtain your installation ID and a link to the activation website http://store.
esellerate.net/store/support/ManualActivation.aspx. After entering the Installation ID you will obtain Activation Key - save it or print it and 
fill it back in the dialog when prompted. If you have closed the dialog on the first computer meanwhile, start activation again with Manual 
Activation checked and choose I already have an Activation Key and would like to activate now. You will be prompted for the Activation Key 
again.

Activation Transfer
If you plan to reinstall your InDesign or entire operating system, or you simply want to utilize your Cross-Reference license on a different 
computer, you should de-activate it first to make sure you’ll stay within your license’s activation limit.

MAC: InDesign à DTP Tools  à Transfer Activation…
WIN: Help à DTP Tools  à Transfer Activation…

Transfer DTP Tools Activation dialog will prompt you for a serial number of the installed plug-in. If you have more serial numbers, you can 
easily find out which is used by checking the list of used serial numbers. The last part is replaced by XXXX to prevent unauthorized manipula-
tion. Serial number in full form is in your order confirmation e-mail. If you can not find it, contact support@dtptools.com preferably using the 
same e-mail address as for ordering.
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